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Understanding N4C Competitions 
The Livermore Valley Camera Club (LVCC) is a member of a regional collective of 16 Greater 
Bay Area camera clubs known as the Northern California Council of Camera Clubs (N4C), 
www.n4c.org). As such, the club competition is based primarily on the guidelines set up by N4C. 
Therefore, the Livermore Valley Camera Club adheres to the standards set forth by N4C for rules 
of competition and judging. For more information, go to the N4C website, 
www.n4c.org/competitions/.  

The club’s semi-monthly meetings focus on competitions critiqued by outside judges where 
members compete against other members of similar abilities. Competitions at all camera clubs 
are intended to be healthy, fun, and a means to improve one’s photography. Members should use 
the competition as a motivational tool to improve their own work. Points are kept for the 
purposes of grouping photographers with similar abilities and experiences together. It is also a 
measure of a member’s participation level in the club.  

In order to enter images in competition, a new member’s skill level must be determined by the 
club officers. To help us do that, email six to ten digital images to the club’s membership 
chairperson at membership@livermorevalleycameraclub.com. If you need help on resizing 
images to send via email, please ask a club officer. Prints can be presented for evaluation by 
special request. 

The top images in each level are forwarded to N4C. At N4C, the LVCC images are judged 
against the winning entries from other clubs, and results are reported in the monthly N4C 
newsletter. Winning N4C entries are eligible for the end-of-year competition, and are presented 
at the annual N4C banquet.  

Regardless of how you may feel about competition and points, we encourage your participation! 
Sharing our photos is at the heart of what Camera Clubs are all about!  

The following information has been condensed from the club by-laws. This is intended to be a 
quick reference for new and existing members. While these rules may seem complex at first, 

http://www.n4c.org/
http://n4c.org/competitions/
mailto:membership@livermorevalleycameraclub.com
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really the best way to understand them is to come to a meeting and see how it all works. Our 
members will help you, and answer any of your questions. 

Competition Divisions 
The club adheres to the standards and guidelines set forth by N4C for competition divisions. The 
Livermore Valley Camera Club participates in the following divisions: 

Printed Images  Projected Images 
Pictorial Color (P) Pictorial (P) 
Pictorial Monochrome (M) Monochrome (M) 
Nature (N)  Nature (N) 
Creative (C)  Creative (C) 
Travel (T)  Travel (T) 
Journalism (J)  Journalism (J) 
Sequence (S)   

 

For complete information on N4C divisions and their definitions, please see the N4C website: 
www.n4c.org/definitions/.  Following the guidelines on the N4C website improves the chances 
that your images will do well in competition both at the club level and the N4C level.  

Note that for all divisions, image titles are read during judging.  Therefore the title is an 
important aspect in understanding the image or story that is presented to the viewer.  Nature titles 
should be concise and include the Latin name if possible.  Be as specific as possible: Include 
activity, behavior, etc. When the whole subject is not shown, you may use “Portrait of ...”. 

Authentic Wildlife Sub-Division for Projected Images  
Any winning projected image from the Livermore Valley Camera Club may also be eligible for 
the Wildlife competition when it is moved on to N4C competition. At N4C interclub 
competitions there is also a sub-division for nature projected images called "Authentic Wildlife." 
This is generally defined as one or more animals living free and unrestrained in a natural or 
adopted habitat. Therefore, photographs of zoo or game-farm animals are not eligible.  

Authentic Wildlife projected images should be designated as such when entering them into 
competition. This is done with a checkbox on the PhotoClubServices entry form.  

Competition Levels 
Within each division there are group levels. Each "level" signifies photographers of similar 
abilities. Each member competes in a division in the group corresponding to the level he/she has 
achieved in that division. For example, it is possible for a member to compete in Projected Image 
Pictorial Advanced, and compete in Printed Image Pictorial Monochrome Intermediate. New 
members are typically placed in the various levels by submitting sample images to the Placement 
Committee after they join. Previous club experience or photo experience is taken in account. 
Printed and Projected levels with their abbreviations are as follows: Basic (B), Intermediate (I), 
Advanced (A) and Masters (M). Note that not all Printed Image divisions have all levels; below 
is the list of Printed Image divisions and their associated levels: 

http://n4c.org/definitions/
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Note that not all Printed Image divisions have all levels; below is the list of Printed Image 
divisions and their associated levels: 

Printed Image Division Printed Image Division Levels 
Pictorial Color B, I, A M 
Pictorial Monochrome B, I, A, M 
Nature B, A 
Creative B, A 
Travel B, A 
Journalism B, A, 
Sequence One level 

Competition Rules and Judging 
Competitions at all LVCC and N4C meetings are critiqued by an impartial outside judge. Judges 
are experienced photographers and/or are involved in photography in some professional manner: 
photographer, teacher, business owner, etc. 

The judges perform two functions at club meetings. The first is to evaluate images on their 
technical qualities, visual impact, and compliance with N4C rules and to award places for the 
competition. The other purpose, hopefully more meaningful, is not only to critique, but also to 
teach and share their knowledge of photography, in an effort to improve the photography of all 
who attend. 

When entering competitions, it is VERY important to keep in mind that the opinion of the judge 
is just that, an opinion. A judge may not like your particular image on a given night, but rest 
assured that a different judge on a different night might think it’s a wonderful image. Some 
judges are very critical, while others are very constructive and instructive. Don’t let negative 
comments from a judge discourage you. Take it as an opportunity to improve your photography. 

The following rules have been established by the LVCC to meet N4C guidelines for competition:  
 A member may enter any division, but only in member’s own level. 
 Entries are limited to one print per division per weekly competition. 
 Entries are limited to one projected image per division per weekly competition. 
 No print or digital image can be entered more than three times within its division in monthly 

competition without significant changes via cropping, sharpening, etc.  
 No image previously entered into N4C print or digital competition will be eligible for 

subsequent entry in regular monthly competition (except for Club Annual or Inter-club 
competitions).  

 Prints must be properly labeled (see below). 
 Projected and printed images placing 1st, 2nd and 3rd in monthly competitions will be sent to 

N4C for judging, unless member chooses not to submit to N4C.  
 Entries sent to N4C can only be from paid-up members. 
 

For more complete information on N4C competition rules, please see the N4C website: 
www.n4c.org.  

Points are awarded in all divisions and tracked for the purposes of advancing members to higher 
levels. However, the club’s Placement Committee can advance a member to a higher level when 
appropriate. Accumulating points is also an indication of a member’s active participation in the 
club. Points are awarded to winning images based on their position for our monthly and N4C 
competitions. Our Placement Committee meets annually and uses point scores in a statically 
model to determine advancement. Points are awarded in the following manner: 

http://www.n4c.org/
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Points 
Place 

LVCC Level N4C Level 
First 4  5  

Second 3  4  
Third 2  3  
Fourth N/A 2  

5th & HM N/A  1  
Best Image +1  +1  

Printed Image Competition 
For any print submitted to the club for competition must be mounted in some fashion; either 
flush to a mat or foam core board, or framed with mat board. The N4C Interclub Competition 
Rules document states "Entries in all print divisions and competition levels (including 
Panoramic print entries) shall be mounted such that the entry is self-supporting (e.g. 2-or 4-ply 
mount board, foam core board, styrene, or other semi-rigid material excluding metal and 
acrylic)." 

The print should be securely assembled, so parts of the mounted print will not seperate. The 
minimum outside measurement for any print mat is 11x14 inches; and the maximum is 16x20 
inches; with a maximum thickness of 5/16 inch. The print itself, inside the mat, may be any size.  

Prints entered in competition must also have a label affixed to the back of the print, in the upper-
left corner, with the following information:  

 Title  
 Maker’s Name  
 Club Name  
 Division (see above)  
 Level (see above)  

 

There is no mandated label, but all information on the label MUST BE PRINTED, machine 
printed, not hand printed. Prints with labels containing handwritten information may be 
disqualified. It is highly recommended that members print the label generated when submitting 
an image to competition using LVCC's Photo Club Services web site discussed below. 

Note that the maker’s name may not appear on the front of the print because judges do not want 
to know who made the print so they can be impartial. Also, the print should not be framed. 

Projected Image Competition 
The maximum size for an image is 1920 pixels wide by 1200 pixels high. While an image can 
have smaller pixel dimensions, the website will scale down images with larger pixel dimensions 
to the maximum allowed dimensions. The image should be saved as a JPEG with an sRGB 
(sRGBIEC61966-2.1) color space. 

Similar to prints, projected images must be submitted as digital files via the Photo Club Services 
website (http://lvcc.photoclubservices.com) before midnight on the day before the competition. 
Instructions and tutorials for using the PCS website can be found on the site.  

Submitting Images for Competition 
Submissions to both print and projected competition must be done through LVCC's Photo Club 
Services (PCS) website (http://lvcc.photoclubservices.com). A digital file of your image—even 

http://lvcc.photoclubservices.com/
http://lvcc.photoclubservices.com/
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in the Printed Image category—must be uploaded to the website prior to the meeting where it 
will be judged. The deadline for doing so is midnight on the night before the meeting.  

Preparing a Digital File for Competition  
Digital images must be no larger than 1920 pixels wide and 1200 pixels high. It is highly 
recommended that one of the images dimensions is equal (or is very close) to one of these 
dimensions without exceeding the maximum second dimension.  

The following steps apply to Adobe Photoshop CS2 through CS6 and probably to current CC 
versions. You may need to modify them if you’re using another program. 

1. Open the file in Photoshop  

2. Flatten the image, if it has layers (Layer>Flatten Image) 

3. Resize the image for projection (Image>Image Size) 
 Be sure Resample Image is checked.  
 For a landscape orientation: Enter 1920 for the width in the Pixel Dimensions boxes; 

the height should be less than 1200 
 For a portrait orientation:  Enter 1200 for the height in the Pixel Dimensions boxes; 

the width should be less than 1920. 

4. Select the sRGB Color Space (Edit>Convert to Profile). 
 From the pulldown menu in Destination Space select “sRGB IEC61966–2.1.” 

5. Save the file as a JPEG (File>Save As) 
 Select a JPEG quality of 12.  

6. Submit the image via the PCS website by midnight of the day before the meeting where it 
will be entered into competition. 

Using the Photo Club Services Website to Submit Your Image  
To submit images, both printed and projected images, into competition, go to LVCC's Photo 
Club Services (PCS) website at http://lvcc.photoclubservices.com.. As part of your club 
application, you should have created a login name and password for this site. If for some reason 
you do not have one or it does not work, please contact the club’s webmaster, 
webmaster@livermorevalleycameraclub.com. 

1. Go to http://lvcc.photoclubservices.com 

2. Log on with your username and password. 

3. Select the Competitions menu. 

4. Select the action Submit Images to a Competition. 

5. Click on the Select button for the correct competition date and category. A page titled Submit 
Images to a Competition will load. It contains links to several how-to videos which you may 
wish to view. 

6. At the bottom of the page click on the Upload Image into the Competition button. There is 
also the possibility to submit previously uploaded images from your Image Library, which 
may be useful at a later time. 

7. At the bottom of the page click the Select button. A popup window will prompt you for an 
image to upload. Select your chosen image on your computer to upload.  

8. At the bottom right of the page, click the Save Images and Proceed to Edit Page button. 

http://lvcc.photoclubservices.com/
mailto:webmaster@livermorevalleycameraclub.com
http://lvcc.photoclubservices.com/


  Page 6 

9. On the next page, fill in the requited information, including title. 
A. For all Divisions, titles may be no more than 200 characters in length.  
B. Titles must not contain any of the characters ~ \ / : " ? | < > 
C. Whatever is in the Title box will become the title displayed during competition. Do not 

include the file name. 
D. The Author's Image Id is not required. It can be use to identify the image later in your 

image library, if you wish. 

10. Click on the Save any changes and return to the original page button to complete the 
submission. 

11. On the bottom of the next page verify all the information is correct. There are also buttons to 
edit image data, replace the image, delete the image from competition and also delete the 
image from your image library. 

12. Also on this page is the Print Labels for Print Submissions button, which will take you the 
mechanism to print a Print label. 

A. Labels are formatted to print on 3-1/3in x 4in Avery 5164/8164/8464 labels. There are six 
labels per sheet. It is also possible to print labels on plain paper (or better yet photo 
paper) and glue the label to the back of the mounted print. The Avery labels are a lot 
easier. 

B. Enter the appropriate values in the Starting Label Column and Starting Label Row fields 
depending on the labels left on the sheet. 

C. Click the Generate Report button. 

D. A preview page will come up. Click the Print icon (the last icon). Depending on the 
browser you use, you may be able to save the generated PDF or open it in Adobe Acrobat 
from which you can print the label. 

E. Do some test with plain paper. The label printing procedure can be repeated as often as 
you wish. Some experimentation may be require on you part. 

13. That’s it; wait for the meeting and see what the judge has to say. 
 

Note that the Photo Club Services website offers spell check. You should take advantage of that, 
but be aware that it will not catch exotic place names that might be incorporated in Travel or 
Nature titles, and certainly not Latin name misspellings. 

Competition Schedule 
The current LVCC competition schedule can be downloaded from the PCS web site at 
https://lvcc.photoclubservices.com/Club/Downloads.aspx under the Competition Information 
category. Always check the club calendar and announcements as holidays may cause actual 
competition dates to change.  

For all projected-image and printed-image categories, the top three places are submitted to N4C 
for interclub competition. Prints will be returned two months after original submission. Monthly 
N4C judging is held at various locations. N4C judging sessions are open to guests. Please contact 
the N4C Representative for more information on attending the N4C judging. 

https://lvcc.photoclubservices.com/Club/Downloads.aspx
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